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I 
 

INTRODUCTION 
 

Computer based information systems proved to be very efficient and effective 
tools for managing data and information to aid in decision making. FAO (2000) 
proposed agricultural knowledge and information system  for rural development 
(AKIS/RD) to link rural people and institutions to promote mutual learning and 
generate, share and utilise agricultural technology, knowledge and information. This 
serves as a vehicle for sharing ideas and principles with various stakeholders 
addressing the problems and seeking solutions to rural development. Although the 
rural development planning is top-down prescriptive approach, in reality the 
decisions are made by the stakeholders based on their perspectives, knowledge and 
priorities. The problems particularly related to environmental impacts are location-
specific and contextual. Geo-spatial technologies may serve as a better vehicle to 
store and share all kinds of location-specific data and information.  The state of 
mapping and management of geospatial data changed during the recent years with the 
diffusion of modern geospatial information technologies such as GIS (Geographic 
information system), GPS (Global positioning system) and image analytical system 
for remote sensing (RS) data. Adinarayana et al., (2008) proposed a geographical 
information and communication technology (Geo-ICT) based information system 
called Grama Vikas (rural development) to assist the user in analysing the rural 
information for rural development/planning. During the recent years there is a 
paradigm shift in GIS applications for rural development particularly in developing 
countries, by way of integrating top-down approach with bottom-up approach by the 
stake holders who stand to be affected by the decisions based on these technologies. 
The emerging concepts include "community - integrated GIS", "GIS in participatory 
research" and ‘participatory GIS” (Abbot et al., 1998; Reddy and Rao, 2009). 

There is an increasing interest in using GIS in a participatory context for 
environmental impact assessment (Algon, 2007) during the recent years. Aquaculture 
in recent years is one of the thrust areas in the Indian economy. The growing demand 
for aqaculture products, the fast depletion and degradation of natural resources, and 
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rising costs of inputs, implicitly states that the judicial use of resources is inevitable 
for sustainable development of aquaculture.  In the wake of commercialisation and 
globalisation, agriculture lands and nearby forests of the aquaculture location are 
swiftly changing their shape into culture ponds. The need for food security and 
commercial benefits drive potential environmental displacement and degradation in 
coastal ecosystem besides, affecting the sustainability by over-exploitation for short-
term benefits. With the development of aquaculture sector, environmental issues 
became of increasing concern. The potential effects of aquaculture activities include 
impacts on water and sediment quality, and negative impacts on natural populations, 
landscape, and other pre-existing economical activities. To a great extent, these 
effects depend upon factors such as type of facilities, adopted technologies, 
geographical location and scaping, and produced species etc. As the environmental 
impacts are location-specific, the main goal of this study is to develop an independent 
software product on “Managing Geo-Spatial Information Management System for 
Managing Aquaculture”. The broad objectives are: (a) to share and disseminate and 
update spatial and non-spatial data and information including stake holders 
perspective on aquaculture technologies and their impacts and (b) to make useful 
spatial database queries and generate required thematic maps along with tables and 
graphs for effective decision making on sustainable development of aquaculture. 

 
II 

 
GEOSPATIAL INFORMATION SYSTEM 

 
This geospatial information system is developed as a deployable windows 

application using Map Objects GIS software, an object model for developing 
deployable GIS applications in Visual basic programming language and back end 
data base as Microsoft Access. The architecture of the geospatial information system 
is shown in Figure 1. Developers can use MapObjects to create applications that 
include dynamic live maps and GIS capabilities. Map Objects offers direct support 
for a wide variety of data sources such as Standard GIS formats we can add mapping 
components to enhance the existing applications. Besides they can build lightweight 
data viewing applications, Create customised mapping and GIS programmes that 
fulfill the specific tasks and requirements and develop simple query-based 
applications that easily enable access to data generated by sophisticated GIS 
solutions. MapObjects provides powerful spatial and attribute filters to optimise 
performance. MapObjects contains a collection of common utilities used in 
ArcExplorer, as well as sample applications demonstrating these components, that 
provide a framework for further development. MapObjects supports dynamic 
tracking for points, lines, polygons, rectangles, and ellipses, making it easy to manage 
GPS activities. 
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Figure 1. Architecture of the   Geospatial Information  
System for Managing Aquaculture 

 
 

 

 

 
 

Figure 1. Agriculture of the Geospatial Information  
System for Managing Aquaculture 

 
III 
 

ACQUISITION OF SPATIAL AND ATTRIBUTE DATA 
 
Selection of Study Area 
 

The study area is identified of villages based on the intensity of spatial 
distribution of aquaculture ponds. For this the spatial distribution of ponds from 
Google Earth database is studied in GIS environment. The various steps involved are 
as follows:- 
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1. Produce identified village maps showing the spatial distribution of 
aquaculture ponds in GIS environment (Geo-referencing). 

2. Collect data and information. 
  
Data and Information: Details on technology adopted in terms of inputs such as 

seed, fertiliser, pesticides etc., and management factors. 
 

Using PRA (participatory rural appraisal) tools and techniques: 
 
a) Semi-structured interviews with key informants 
b) Time line and change analysis 
c) Village resource map 
d) Agro-ecological map 
e) Map showing soil pollution 
f) Map showing water pollution 
 

3. Validating all the spatial data and maps using GPS (Global Positioning 
System).  

4. Geo-referencing and correcting village maps derived from PRA tools.  
 
The image derived from google earth represents the actual spatial distribution of 

various features on the ground in the study area. The google earth image data is 
imported to GIS software, ArcGIS and different themes such as aquaculture ponds, 
vegetation, roads, settlements, canals were vectorised based on the information on 
village  boundary collected through participatory approach as different layers. Vector 
map of different layers is shown in Figure 2. 

 
 

 

 

 

** 

Figure 2. Map of the Study Area of Korangi Panchayat Derived Through 
Participatory Approach. 
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The map clearly shows the spatial distribution of aqua ponds along with the other 
land use categories. This map produced by participating GIS method (PGIS) is more 
accurate than the maps being produced by traditional PRA methods. These maps in GIS 
are the basic input to model environmental impacts and its dynamics over time and 
space. These separate layers are required for implementation of spatial sampling with 
respect to aquaculture ponds. There are 449 aquaculture ponds in the study village and 
this layer is the sampling frame for implementing spatial sampling algorithms to collect 
spatially representative data on pond details. Different layers include spatial data on area 
under crops, irrigation canals, roads, village administrative buildings, hospitals, schools 
and other important elements which can be helpful in the process of identification, 
geodatabase creation, documentation and digitisation. After completing the above tasks, 
the important facet of the study is to validate the information obtained through field 
survey with the help of local villagers, and again checking the digitised map in the field 
for authentication. The villagers and the farmers were gathered in a place and they were 
shown the Geo-referenced Google earth map and were asked to locate their ponds, and 
validated  the previously collected data. Some of the interesting facts revealed in the 
observation were that some of the agricultural fields were converted into aqua ponds and 
vice versa. Also some of the mangrove forests surrounding the aquaculture habitat lost 
their ground in the expansion of culture ponds.  

 
IV 

 
GEOSPATIAL INFORMATION SYSTEM 

 
The main page (Figure 3) appears and a set of selection boxes for district, village, 

layer and attributes which allow selection of a district, village within the selected 
district, layer within the selected village, attribute within the selected village. 

 

 

Figure 3. Main Screen of Geo-spatial Information System 
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It contains the buttons to images, video, and statistics when you click on the 
button it will go to the corresponding form. The user can come back to the first screen 
by clicking on the button Home. 

The main page contains a menu bar of four Menu Items File, View, Layers and 
Help. 

The File menu contains Exit option. The View contains Full Extent, Zoom in, 
Zoom out, Pan and Identify. The Layer menu contains Add Layer, Remove Active 
Layer and Legend Editor as menu Items. The Help menu contains About as menu 
item. 

Clicking on Apply after selecting the district, village, layer and attributes it shows 
google earth image and the corresponding spatial layer is displayed in the map 
window.  The X, Y Coordinate of the locations are displayed in the bottom of the 
window. These changes happen as mouse pointer moves over the map window. The 
user can select a particular attribute of his interest, after selecting attribute and click 
on apply then it displays the map, corresponding tabular data. We can Zoom in and 
Zoom out particular area of on the map by selecting the Zoom In and Zoom Out 
buttons in the Tool bar.   Pan tool lets you pan a view by dragging the display in any 
direction with the mouse. To pan, move the cursor anywhere over the view, hold 
down the mouse button, and drag in any direction. Release the mouse button to leave 
the display in your desired position.  As a view can contain themes with different 
spatial extents, Zoom to Full Extent enables you to set an extent that covers all the 
themes in the view. Use this option when you want to be able to see everything in a 
view. Full extent control zooms to the extent of all the themes in the view, whether or 
not they are currently visible or active.  The Identify tool displays its results in a 
dialog box.  

 

 

Figure 4. Identify Button 
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(i) Click on the Identify button    and 
(ii) Click on the Fish Pond polygon to know the details of individual polygons.  

 
To display the thematic map of Fishpond area: 
 

(i) Select the layer in legend, double click on the selected Layer, then a pop 
window displayed as showed in Figure 5. 
 

 

Figure 5. Thematic Mapping using Symbol Properties 
 

(ii) Select Unique in the SSTab control 
(iii) Click on the Field to obtain a drop down list of Fishpond Attributes, which 

can be mapped. 
(iv) Select PH in the dropdownlist box 
(v) Click on Reset Legend 
(vi) Click on Apply and OK. 

 
 Thematic map showing the spatial distribution 0g PH will appear as shown in  
Figure 6. 
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Figure 6. Thematic Mapping of PH 
 

V 
 

CONCLUSION 
 
Information technology is identified as the key factor in economic growth. 

Hence, Government of India  is implementing  the village knowledge centres (VKC) 
programme (http://capart.nic.in/scheme/vrc.pdf) to bring access to range of services, 
content and information to people living in villages. GIS is a platform for sharing the 
learnings from local communities by creating a pool of knowledge/information by 
others for further learning and effective decision making, sharing knowledge and 
information including spatial data, information and knowledge  results in innovations. 
Today, participatory  rural development (PRA)  is being widely used methodology 
for an interactive process for planning social development. PRA has been described 
as a growing family of approaches and methods to enable local people to express, 
enhance, share and analyse their knowledge of their livelihoods to plan and act 
(Chambers, 1994). Communication is a two way process. Involving stakeholder in 
the research and planning process has its own implications. The revolutionary 
changes and applicability of the Geo-spatial Information Technology has many 
facets, and one such component is in using it to investigate and document the data of 
natural resources at micro level. The more the public participation the more complex 
the planning will become, but the proposed geo-spatial information system will help 
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to address the complex spatial problems and in taking effective decisions for local 
level planning by sharing the spatial data and information by all stakeholders.  
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